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The Spring Container

* The container will:
— create the objects
— wire them together
— configure them

— manage their complete lifecycle from creation
till destruction.

* These objects are called Spring Beans
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Dependency Injection

* The Spring container uses dependency
injection (DI) to manage the components

* In a complex Java application classes
should be as independent as possible to
iIncrease the possibility to reuse these
classes and to test them independently

* Dependency Injection helps in connecting
these classes together and same time
keeping them independent.
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DIl Implementation
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Container’'s Metadata

 The container gets its instructions on
what objects to instantiate, configure,
and assemble by reading configuration
metadata provided:
— by XML
— Java annotations
— Java code

Victor Mozharsky



How Spring Works

JavaPOJO classes

Metadata

The Spring container

Final Result

Readyto use
application
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Spring Bean Definition

* The objects that form the backbone of your
application and that are managed by the
Spring 1oC container are called beans

* The bean definition contains the information
called configuration metadata which is
needed for the container to know:

— How to create a bean
— Bean's lifecycle details
— Bean's dependencies

Victor Mozharsky 7



XML Metadata

<?xml version="1.0" encoding="UTF-8"7?>
<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalocation="http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans-3.0.xsd" >
<l-- Bean declarations go here -->
</beans>

* Victor Mozharsky 8



Spring Bean Definition

 Each bean definition can contain a set of

the following properties:
— Class

— Name

— Scope

— constructor-arg

— Properties

— autowiring mode

— lazy-initialization mode

— Initialization method

— destruction method
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Bean Definition Attributes

» Class attribute is mandatory and specify the
bean class to be used to create the bean

* Name attribute specifies the bean identifier
uniquely. In XML-based configuration
metadata, you use the id and/or name
attributes to specify the bean identifier(s)

* Properties is used to inject the dependencies

Victor Mozharsky 10



Spring Tool Suite Installation

Open Eclipse -> Help -> Eclipse
Marketplace...

Find = STS -> click Find button -> select STS for
Eclipse Luna -> Install button -> Confirm -> |
accept -> Finish

Restart Eclipse
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Example 1. Hello World in Spring

Create Spring project

Tune project for logging

Create project classes (POJOs)
Create Spring metadata

Create application context

Run application

o0k w0
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Example 1. Create Spring Project

* File -> New -> Other.. -> Spring -> Spring
project -> Next

* Project name = P211BeanDefinition,
Templates = Simple Spring Utility Project
-> Next

* Package = com.bionic.edu -> Finish

Victor Mozharsky 13



Example 1. Create Spring Project

 Remove from com.bionic.edu package
(src/main/java) template files Service.java
and ExampleService.java

 Remove from com.bionic.edu package
(src/test/java) template files
ExampleConfigurationTests.java and
ExampleServiceTests.java

Victor Mozharsky 14



Example 1. Logging Dependencies

Group Id

org.slf4j
org.apache.logging.log4j

org.apache.logging.log4j
org.apache.logging.log4j.adapters
org.apache.logging.log4j

org.apache.logging.log4j

Artifact Id

slf4j-api
log4j-api

log4j-core

log4j-slf4j-impl

log4j-taglib

log4j-jcl

Version

1.7.5
2.0.2

2.0.2

2.0-betad

2.1

2.0.2
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Add Dependencies to the
pom.xml File

1. Open pom.xml -> Dependencies tab ->
select junit: 3.8.1[test] -> Properties ->
change version to 4.7 -> Ok

2. Press Add button -> Groupld = org.slf4j,
Arifactld = slf4j-api, Vesion = 1.7.5 -> Ok

3. Press Add button -> Groupld = org.apache.
logging.log4j, Artifactld = log4j-api, Version
=2.0.2 -> Ok

4. And soon... Then -> Save

16



Further pom.xml Tuning

» Select log4j (1.2.14) dependency and click
Remove button

* Go to pom.xml tag and change 1.5 Java
version to 1.8 both in <source> and
<target> tags of maven-compiler-plugin
artefact

* Change Spring version to 4.1.1.RELEASE
In <spring.framework.version> tag

« Save pom.xml file

Victor Mozharsky 17



Maven clean&install actions

1. Right click on the project’'s name ->
Maven -> Update project -> Ok

2. Right click on the project’'s name -> Run
As... -> Maven clean

3. Right click on the project’'s name -> Run
As... -> Maven install

18



Example 1. Hello World in Spring

Create Spring project

Tune project for logging

Create project classes (POJOs)
Create Spring metadata

Create application context

Run application

o0k w0 =
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Example 1. log4j2.xml in resources

<?xml version="1.0" encoding="UTF-8"?>
<configuration status="WARN">
<appenders>
<Console name="Console" target="SYSTEM_OUT">
<PatternLayout pattern="%d{HH:mm:ss.SSS} [%t] %-5level
%logger{36} - Y%omsg%n"/>
</Console>
</appenders>
<loggers>
<root level="warn">
<appender-ref ref="Console"/>
</root>
</loggers>
</configuration>

* Victor Mozharsky 20



Example 1. Hello World in Spring

Create Spring project

Tune project for logging

Create project classes (POJOs)
Create Spring metadata

Create application context

Run application

o0k 0=
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E1. GreetingService Interface

package com.bionic.edu;

public interface GreetingService {
void sendGreeting();

J

Victor Mozharsky
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E1. HelloWorldService Class

package com.bionic.edu;

public class HelloWorldService implements
GreetingService {
public void sendGreeting() {
System.out.printin("Hello, world!");

J

Victor Mozharsky
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E1. HelloKittyService Class

package com.bionic.edu;

public class HelloKittyService implements
GreetingService {

public void sendGreeting(){
System.out.printin("Hello, Kitty!");

J

Victor Mozharsky
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Example 1. Hello World in Spring

Create Spring project

Tune project for logging

Create project classes (POJOs)
Create Spring metadata

Create application context

Run application

o0k 0=
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Bean Definition

* The <bean> element tells Spring to create
an object for you.

* The id attribute gives the bean a name by
which it'll be referred to in the Spring
container.

* When the Spring container loads its beans,
it'll instantiate the bean using the default
constructor.

Victor Mozharsky 26



Example 1. Bean Definition

<bean id="helloWorldService"
class="com.bionic.edu.HelloWorldService" />

Victor Mozharsky 27



Example 1. Configuration File

 Right click on src/main/resources -> New
-> File

* Fill File name with configuration file Id
(beans.xml) -> Finish

» Create configuration file context (see next
slide) -> Save
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Example 1. Configuration File

<?xml version="1.0" encoding="UTF-8"?>

<beans xmlns="http://www.springframework.org/schema/beans”
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"”
xsi:schemal.ocation="http.//www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans-3.0.xsd">

<bean id="helloWorldService"
class="com.bionic.edu.HelloWorldService" />

</beans>
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Example 1. Hello World in Spring

Create Spring project

Tune project for logging

Create project classes (POJOs)
Create Spring metadata

Create application context

Run application

o0k w0
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Application Context

* You can load the Spring application
context using the following code:

ApplicationContext ctx = new
ClassPathXmlApplicationContext("beans.xml");

GreetingService service =
(GreetingService)ctx.getBean("helloWorldService");

service.sendGreeting();
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Example 1. Application Class

package com.bionic.edu;
import org.springframework.context.ApplicationContext;
Import org.springframework.context.support.ClassPathXmlApplicationContext;

public class Application {

public static void main(String[] args) {
ApplicationContext ctx = new ClassPathXmlApplicationContext("beans.xml");
GreetingService service =
(GreetingService)ctx.getBean("helloWorldService");
service.sendGreeting();

}

* Victor Mozharsky 32



Example 1. Hello World in Spring

Create Spring project

Tune project for logging

Create project classes (POJOs)
Create Spring metadata

Create application context

Run application

o0k W=
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Example 1.

* Run application. You will get
Hello, world!

« See P211BeanDefinition project for the full
text
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Injecting through Constructors

A class can be constructed in two different
ways:
— Using the default constructor
— Using a constructor that takes an argument(s)

* If no <constructor-arg> are given in a bean
definition, the default constructor is used.

* A <constructor-arg> with a value attribute
leads to the other constructor will be used
Instead.
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Example 2. HelloWorldService

package com.bionic.edu;
public class HelloWorldService implements GreetingService

{

public String message;

public HelloWorldService(){ message = ""; }
public HelloWorldService(String message
this.message = message;

}

public void sendGreeting() {
System.out.printin("Hello, world! " + message),

}

Victor Mozharsky 36



Example 2. Bean Definition

<bean id="helloWorldService"
class="com.bionic.edu.HelloWorldService">

<constructor-arg value="I am Victor." />
</bean>

Victor Mozharsky
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Example 2.

* Run application. You will get
Hello, world! | am Victor.

» See P212Constructorinjection project for
the full text

Victor Mozharsky
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Injecting Object References

* You should use ref attribute in a
<constructor-arg> for passing references to
other beans

Victor Mozharsky
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Example 3. Application Class

public class Application {
GreetingService greeting = null;
public Application(){}
public Application(GreetingService greeting){ this.greeting = greeting; }

public static void main(String[] args) {

ApplicationContext ctx = new

ClassPathXmlApplicationContext("beans.xml");

Application application = (Application)ctx.getBean("application");
application.start();

}

public void start(){

if (greeting != null) greeting.sendGreeting();

1}
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Example 3. Bean Definition

<bean id="helloWorldService"
class="com.bionic.edu.HelloWorldService">
<constructor-arg value="l am Victor." />
</bean>
<bean name="application"” class="com.bionic.edu.Application">
<constructor-arg ref="helloWorldService" />
</bean>

Victor Mozharsky 41



Example 3 Output

 Hello, world! | am Victor.

Victor Mozharsky
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Example 3. Bean Definition

<bean id="helloWorldService"
class="com.bionic.edu.HelloWorldService">

<constructor-arg value="l am Victor." />

</bean>

<bean id="helloKittyService"

class="com.bionic.edu.HelloKittyService" [>

<bean name="application"” class="com.bionic.edu.Application">
<constructor-arg ref="helloKittyService" />

</bean>

Victor Mozharsky 43



Example 3 Output

+ Hello, Kitty!

» See P213Constructorinjection project for
the full text

Victor Mozharsky
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Property Tags

* You can use <property> tag to pass the
values of different variables used at the
time of object creation

* <property> is similar to <constructor-arg>
INn many ways, except that instead of
Injecting values through a constructor
argument, <property>injects by calling a
property’s setter method.
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Example 4. Simple Value Injection

1. Add accessor to HelloWorldService class
2. Change beans.xml as follows

<bean id="helloWorldService" class="com.bionic.edu.HelloWorldService">

<property name="message"” value="l am Victor." />
</bean>
<bean id="helloKittyService" class="com.bionic.edu.HelloKittyService" />
<bean name="application" class="com.bionic.edu.Application">
<constructor-arg ref="helloWorldService" />

</bean>
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Example 4. Output

 Hello, world! | am Victor.

« See P214PropertySimple project for the
full text

Victor Mozharsky
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Simple Value Injection

» <property> isn’t limited to injecting String
values
* The value attribute can also specify

numeric (int, float, java.lang.Double, and
so on) values as well as boolean values
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Example 5. Numeric Injection

public class HelloWorldService implements GreetingService {
public String message;
public int repeat;

// constructors, getters&setters

public void sendGreeting() {
for (inti=0;i<repeat; i++){
System.out.printin("Hello, world! " + message),
}

1}
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Example 5. beans.xml

<bean id="helloWorldService" class="com.bionic.edu.HelloWorldService">
<property name="message"” value="l am Victor." />
<property name="repeat” value="3" />
</bean>
<bean id="helloKittyService" class="com.bionic.edu.HelloKittyService" />
<bean name="application"” class="com.bionic.edu.Application™
<constructor-arg ref="helloWorldService" />
</bean>

* Victor Mozharsky 50



Example 5. Output

 Hello, world! | am Victor.
 Hello, world! | am Victor.
 Hello, world! | am Victor.

« See P215Numericlnjection project for the
full text
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Object Injection

* The real value of Dl is found in wiring an
application’s collaborating objects together
so that they don’t have to wire themselves
together

« Use ref attribute of <property> tag for this
purpose
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Example 5. Reference Injection

1. Add getter&setter for greeting field of
Application class

2. Change beans.xml as follows

<bean id="helloWorldService" class="com.bionic.edu.HelloWorldService ">
<property name="message" value="l am Victor." />

</bean>

<bean id="helloKittyService" class="com.bionic.edu.HelloKittyService" />

<bean name="application” class="com.bionic.edu.Application">
<property name="greeting” ref="helloKittyService" />
</bean>
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Example 5. Output

+ Hello, Kitty!

Victor Mozharsky
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Example 5. Bean.xml| Changes

<bean id="helloWorldService" class="com.bionic.edu.HelloWorldService">
<property name="message" value="l am Victor." />

</bean>

<bean id="helloKittyService" class="com.bionic.edu.HelloKittyService" />

<bean name="application” class="com.bionic.edu.Application">
<property name="greeting" ref="helloWorldService" />
</bean>
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Example 5. Output

 Hello, world! | am Victor.

« See P216PropertyRef project for the full
text

Victor Mozharsky
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Auto Wiring

* |n large applications, the number of beans will
Increase and the corresponding XML written to
configure the numerous beans will become very

large

» Spring provides a feature called 'Auto-Wiring'
that minimizes the XML to be written provided
that certain assumptions are made about the
nomenclature of beans and properties

» Spring provides auto-wiring based on both XML
and Annotations
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Auto-Wiring based on Annotations

» Use the <context:component-scan> tag in
spring-context.xml

» Use the @/nject annotation to qualify
either the member or a corresponding
method (usually the setter method) which
takes the injected type as argument
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The @/nject annotation

* The @Inject annotation can be used to
qualify:
— a member

— any method (including setter method) which
takes the injected type as argument

Victor Mozharsky
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Autodiscovery

» By default, <context.component-scan>looks for
classes that are annotated as:

— @Component - indicates that the class is a Spring
component

— @Controller - indicates that the class defines a
Spring MVC controller

— @Repository - the class defines a data repository
— @Service - the class defines a service

— Any custom annotation that is itself annotated with
@Component
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@Component vs @Named

« @Named and @Component annotations
are used enabling a class to be auto
detected as the bean definition for spring’s
application context

— @Named is part of the Java specification
JSR-330. It is more recommended since this
annotation is not tied to Spring APls.

— @Component is part of the Spring’s
annotations library.

Victor Mozharsky 61



o &~ wb

Example 6. Annotations

. Create Spring project with name

P221Firstinject

Tune pom.xml file

Tune beans.xnm file
Create application classes
Run application

Victor Mozharsky

62



Example 6. pom.xml

» Add the following dependency to the
project’'s pom.xml file:

<dependency>
<groupld>javax.inject</groupld>
<artifactld>javax.inject</artifactld>
<version>1</version>
</dependency>
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Example 6. beans.xml

 Create the following beans.xml file:

<?xml version="1.0" encoding="UTF-8"?>

<beans xmins="http.//www.springframework.org/schema/beans”
xmlns:xsi="http.//www.w3.0rg/2001/ XML Schema-instance"”
xmlins:context="http.//www.springframework.org/schema/context"

xsi:schemal.ocation="http://www.springframework.org/schema/beans
http.//www.springframework.org/schema/beans/spring-beans-3.0.xsd

http.//www.springframework.org/schema/context
http://www.springframework.org/schema/context/spring-context-3.0.xsd">

<context:component-scan base-package="com.bionic.edu" />
</beans>
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Example 6. HelloWorldService

package com.bionic.edu;
import javax.inject.Named,;
@Named
public class HelloWorldService implements GreetingService {
public String message;
public int repeat;
public void sendGreeting() {
for (inti=0; i <repeat; i++)
System.out.printin("Hello, world! " + message);
}
}
}

* Victor Mozharsky
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Example 6. Application Class

@Named

public class Application {
@Inject
GreetingService greeting = nuli;
public static void main(String[] args) {

ApplicationContext ctx = new
ClassPathXmlApplicationContext("beans.xml");

Application application = (Application)ctx.getBean("application");
application.start();

}
public void start(){

if (greeting != null) greeting.sendGreeting();

1}

* Victor Mozharsky
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Example 6. Output

 Hello, world!

« See P221Firstinject project for the full text
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Example 7. Autowiring by Name

* Annotate HelloKittyService class with
@Named:

package com.bionic.edu;

iImport javax.inject.Named;

@Named

public class HelloKittyService implements GreetingService

{
public void sendGreeting(){

System.out.printin("Hello, Kitty!");

}
}
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Example 7. Output

* Running the application leads to an

exception

Exception in thread "main”
org.springframework.beans.factory.BeanCreationException

Error creating bean with name 'application': Injection of
autowired dependencies failed;

No unique bean of type [com.bionic.edu.GreetingService] is
defined:

expected single matching bean but found 2:
_[helloKittyService, helloWorldService]
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The @Named Annotation

* If multiple bean types are available for

injection, then Spring will be unable to
make a decision on which bean to inject

and will throw an Exception

* In such cases, we can use the
@Named(name="..") annotation and give
the name of the bean that we want Spring

to inject.

Victor Mozharsky
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Example 7. @Named Annotation

@Named

public class Application {
@Inject
@Named("helloWorldService")
GreetingService greeting = null;
public static void main(String[] args) {

ApplicationContext ctx = new
ClassPathXmlApplicationContext("beans.xml");

Application application = (Application)ctx.getBean("application");
application.start();
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Example 7. Output

* Hello, world!

Victor Mozharsky
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Example 7. @Named Annotation

@Named

public class Application {
@Inject
@Named("helloKittyService")
GreetingService greeting = null;
public static void main(String[] args) {

ApplicationContext ctx = new
ClassPathXmlApplicationContext("beans.xml");

Application application = (Application)ctx.getBean("application");
application.start();
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Example 7. Output

+ Hello, Kitty!

« See P222InjectByName project for the full
text

Victor Mozharsky
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